Applicaton Note /inritsu

LTE Downlink Signal
Multi-Antenna Transmitter Measurement

Timing Difference Between Four Antennas and PDSCH EVM of Each Antenna

MS2690A/MS2691A/MS2692A/MS2830A

Signal Analyzer

MG3710A

Vector Signal Generator



Introduction

This document explains how to output an LTE FDD/TDD downlink signal in a 4-antenna configuration from the
vector signal generator and how to measure the timing difference between the antennas and the PDSCH EVM of
each antenna using a signal analyzer.

The aim of this guide is to provide an understanding of the following items:

® How to simulate and operate one MG3710A Vector Signal Generator outputting signals as a base station with
four antennas

® How to measure the timing difference between the four antennas and the PDSCH EVM of each antenna using
the MS269xA Signal Analyzer

The target readers for this guide are engineers developing and evaluating LTE base stations.
The following diagram shows a simple model of the base station simulated by this demonstration. The base station
has four antennas and performs MIMO transmissions using Tx diversity and spatial multiplexing functions. The

signal output from each antenna has slight relative differences in timing due to the base station design and other
environmental factors.
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Fig. 1. Configuration of Base Station with Four Antennas

This demonstration outputs four simulated antenna signals from the MG3710A Vector Signal Generator with the
baseband signal addition function installed for each of the two RF ports. The Tx0 and Tx1 signals are loaded into
memory A and memory B, respectively, of the SG1 side and the Tx2 and Tx3 signals are loaded into memory A
and memory B of the SG2 side.

The following figure shows the simple block diagram for the MG3710A Vector Signal Generator when simulating

the base station in this demonstration. The Tx0 and Tx1, and Tx2 and Tx3 waveform patterns are added by digital
processing. The baseband blocks and local signals are synchronized between SG1 and SG2 to output the Tx0, Tx1,
Tx2, and Tx3 signals from the MG3710A Vector Signal Generator with fixed relative timings and timing offsets.
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Fig. 2. Block Diagram of MG3710A Vector Signal Generator Simulating Base Station with Four Antennas

The MS269xA Signal Analyzer measures the timing offset between antennas by identifying different reference
signals for each antenna. When performing this measurement, the signal outputs from the two RF ports of the
MG3710A Vector Signal Generator are combined at a combiner and input to the RF port of the MS269xA Signal
Analyzer.

When measuring the Data channel PDSCH EVM, the output from each antenna of the MG3710A is input directly to
the RF port of the MS269xA Signal Analyzer. The number of the antenna to be measured is set at the MS269xA
and the PDSCH EVM of that antenna is measured.

The timing offset measurement in this demonstration refers to the definition of item 6.5.3 Time alignment between
transmitter branches in Rel. 8 and Rel. 9 of the 3GPP TS36.141 standard. Although PDSCH EVM measurement is
defined in item 6.5.2 Error Vector Magnitude of the same standard as measurement for a single antenna, this
demonstration measures the same signal configuration as the timing offset to monitor the modulation accuracy for
multiple antennas.
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Preparations
Prepare the following equipment and software for the demonstration.

® MG3710A Vector Signal Generator (Firmware Ver. 2.00.02 or newer)

Opt-032 1stRF 100 kHz to 2.7 GHz (Opt-034, -036 also OK)
Opt-048 1stRF Baseband Signal Addition

Opt-062 2ndRF 100 kHz to 2.7 GHz (Opt-064, -066 also OK)
Opt-078 2ndRF Baseband Signal Addition

MX370108A  LTE_IQproducer (for LTE FDD)

Or
MX370110A  LTE TDD IQproducer (for LTE TDD)

® MS2690A/MS2691A/MS2692A/MS2830A Signal Analyzer (Firmware Ver. 5.04.00 or newer)
MX269020A  LTE Downlink Measurement Software (for LTE FDD)
Or

MX269022A  LTE TDD Downlink Measurement Software (for LTE TDD)

® RF Cable 3 pcs
® 2 Signal Combiner 1 pc

Connect the instruments as shown in the following set-up diagram.

ol SG2 Out
°3 " Pany
G [;
L 7:
SG1 Out

Fig. 3. Connection Set-up

To simplify the operations described in this application note, the cable attenuation settings and calibration
procedures are omitted. To measure more accurately, refer to the operation manual and add the required
procedures.

Unless otherwise noted, the description of following procedures and figures is for LTE FDD measurement. The
procedures for LTE TDD measurement are similar as for LTE FDD measurement. This document complements the
procedures especially for LTE TDD measurement.
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Creating Waveform Patterns

The LTE FDD/TDD downlink signals are measured under the following conditions in this demonstration. To test the

wireless characteristics using multiple antennas, several parameters differ according to the actual MIMO signal
composition.

Table 1. Main Parameters of Created Waveform Patterns

Parameter Value Remarks
Cell ID 1
Bandwidth 5 MHz
No. of Antennas 4 In this demo, each antenna signal is Tx0, Tx1, Tx2, and Tx3.
Diversity Mode Spatial Multiplexing
No. of Layers 1
Base Signal E-TM1.1 Same as measurement conditions for 6.5.3 Time alignment
between transmitter branches
Synchronization Signal | Only Tx0 enabled

Use the following procedure to create the output signal waveform pattern using IQproducer built into the MG3710A

Vector Signal Generator.

[Procedure]
1. Press [IQpro] to start IQproducer.
2. Press [LTE FDD] at the System (Cellular) tab to start LTE IQproducer
(Press [LTE TDD] for TDD)
Press [Normal Setup].
Press [Easy Setup] = [BS Test] > [E-UTRA Test Models] - [E-TM1.1] to select BW =5 MHz.
Select Common at the top of the tree on the left side of the window.
Set [Number of Antennas] in the Common column at the window center to 4.
In the case of TDD, Set [Test Model] to [Off] before setting of [Number of Antennas].
Select [Synchronization of sighals] in the center of the tree at the left side of the window.
Set [Data Status] of [Antenna Port 1] of [Primary Synchronization signals] at the right side of the window to
[Disable].
9. Similarly, set [Data Status] of [Antenna Port 2] and [Antenna Port 3] to [Disable].
(Set only Antenna Port 0 to Enable.)

o gk w
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10. Set [Data Status] of [Antenna Port 1] of [Secondary Synchronization signals] at the right side of the window to

[Disable].

11. Similarly, set [Data Status] of [Antenna Port 2] and [Antenna Port 3] to [Disable].
(Set only Antenna Port 0 to Enable.)

12. Press [Calculation].

13. Change the package name and output file (waveform pattern) as necessary.
(Refer to the end of this procedure for the name used in this demo.)

14. Press [OK] to start waveform pattern generation.

15. Select [Yes] if the "Folder is not found' message is displayed.

The created waveform pattern setting file can be saved as necessary using [File] > [Save Parameter File]. The
same settings can be recalled by reading this file using [Recall Parameter File].

The following four waveform patterns are created as examples in this demonstration.
Package: LTE_FDD
(“LTE_TDD” for TDD)
Tx0 Waveform Pattern: E-TM_1-1 05M_0
Tx1 Waveform Pattern: E-TM_1-1_05M_1
Tx2 Waveform Pattern: E-TM_1-1_05M_2
Tx3 Waveform Pattern: E-TM_1-1 05M_3
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File Edit Easy Setup Transfer Seting  Simulation
J 'ﬁD % M @l‘% @% {@ %5 s T:i it H % Iit-l Easy Setup
- Common all] Cormrmon | | a|| | Synchronization signals | | a
= Downlink || Swstem LTE |7 |
MNumber of Antennas 4 —| Antenna Port0 —
Diversity Method Spatial Multiplexing Data Status Enable
ch Precoding Method Without CDD Data Type ff-Chu Sequence
& Subframe #0 MNumber of Layers 1 Zadoff-Chy sequence index u 20
PCFICH Number of Code words 1 Power Boosting 0.000
L PDCCH #0 Codebook Index 0 Antenna Port 1
CPDCCH #1 NID(T) 0 Data Status Disable
PDOSCH #0 gl[l)l% j] Data Tyne -Chu Sequence
2 Zadof-Chu sequence Index u 20
= pHIp(':_"_I'Cg;';%D#O Number of Frames 1 Power Boosting 0.000
Cwersampling Ratio 2 Antenna Port 2
LPHICH#L Sampling Rate 15.36 Data Status Disable
[—]--Siubframe #1 Bandwidth 5 Data Tyos -Chu Sequence
PLFICH Dawnlinkd/Uplink Danlink Zadoff-Chu sequence Index u 25
~PDCCH #0 Cyclic Prefix MNormal Power Boosting 0000
~PDCCH #1 Subcarrier Spacing 5 Antenna Port 3
~PDSCH#0 Number of OFDM symb 7 Data Status Disable
=-PHICH group#0 Roll Off Length 0 Daia Tyne f-Chu Sequence
~PHICH#O Filter Zadoff-Chu sequence index u 28
- PHICH#EL Filter Type Mone | o || | FPower Boosiing 0.000 | &
=-Subframe #2 et A Sjroqrion mmohranization oioe
PCFICH 4 | r Ll_l 4 | ] 4
~PDCCH #0
-PDCCH #1
~PDSCH #0
=-PHICH group#0
~PHICH#O
L PHICH# 1 hd
< ﬂ_l

Fig. 4. LTE IQproducer Settings

The above procedure creates and saves four waveform patterns for each antenna to the HDD built-into the
MG3710A Vector Signal Generator.
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Setting Signal Generator

The signal created by IQproducer is output from the MG3710A Vector Signal Generator.

The Tx0 and Tx1 signals are output from the SG1 port of the MG3710A Vector Signal Generator after combining
using the Baseband Signal Addition function. The TxO0 signal is loaded in memory A and the Tx1 signal is loaded in
memory B. The Tx2 and Tx3 signals are output from the SG2 port of the MG3710A after combining using the
Baseband Addition function. The Tx2 signal is loaded in memory A and the Tx3 signal is loaded in memory B.

Table 2. Waveform Pattern Arrangement and Output

Waveform Pattern RF Port Waveform Memory Save
Destination
Tx0: E-TM_1-1_05M 0 SG1 A
Tx1: E-TM_1-1_05M 1 SG1 B
Tx2: E-TM_1-1_05M 2 SG2 A
Tx3: E-TM_1-1_ 05M 3 SG2 B

Additionally, the Local signal for generating the RF signal is synchronized between the two RF ports. This is to
synchronize the signals between antennas when each antenna is connected to each RF port.

The MG3710A Vector Signal Generator operation procedure is explained below.

The operation flow is as follows:

(1) Select waveform at SG1.

(2) Select waveform at SG2.

(3) Synchronize SG1 and SG2 signals, set frequency, level, etc., and output signal.

[Procedure]
(1) Select the waveform at SG1.
1. Press[SG1].
2. Press [Preset] & [F1] Preset to initialize the instrument.
3. Press [Load] and select [LTE_FDD] from the Packages list on the left side of the window.
(Press [LTE TDD] for TDD)
Press [F8] To Memory to set [A].
Select [E-TM_1-1_05M_0] from the Packages list on the right side of the window and press [F6] Load Pattern.
Press [F8] To Memory to set [B].
Select [E-TM_1-1_05M_1] from the Packages list on the right side of the window and press [F6] Load Pattern.
Press [Mode] - [F2] Combination Mode to set [Edit].
Press [Select] > [F8] On Memory to set [A].
0. Select [LTE_FDD] from the Packages list on the left side of the window.
(Select [LTE TDD] for TDD)
11. Select [E-TM_1-1_05M_Q0] from the Packages list on the right side of the window and press [F6] Select.
12. Press [Select] & [F8] On Memory to set [B].
13. Select [E-TM_1-1_05M_1] from the Packages list on the right side of the window and press [F6] Select.
14. Press [Mode] = [F3] ARB Setup - [F3] Output B to set [On].

BOONOGOA

(2) Select the waveform at SG2.
15. Press [SG2].
16. Press [Load] and select [LTE_FDD] from the Packages list on the left side of the window.
(Press [LTE TDD] for TDD)
17. Press [F8] To Memory to set [A].
18. Select[E-TM_1-1_05M_2] from the Packages list on the right side of the window and press [F6] Load Pattern.
19. Press [F8] To Memory to set [B].
20. Select [E-TM_1-1_05M_3] from the Packages list on the right side of the window and press [F6] Load Pattern.
21. Press [Mode] - [F2] Combination Mode to set [Edit].
22. Press [Select] & [F8] On Memory to set [A].
23. Select [LTE_FDD] from the Packages list on the left side of the window.
(Select [LTE TDD] for TDD)
24. Select [E-TM_1-1_05M_2] from the Packages list on the right side of the window and press [F6] Select.
25. Press [Select] = [F8] On Memory to set [B].
26. Select [E-TM_1-1_05M_3] from the Packages list on the right side of the window and press [F6] Select.
27. Press [Mode] = [F3] ARB Setup - [F3] Output B to set [On].
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(3) Synchronize the SG1 and SG2 signals, set the frequency, level, etc., and output the signal.

28. Press [Mode] 2 [—] =2 [F8] Sync Multi SG - [F1] Sync Type > [F4] SG1&2.

29. Press Back = [F4] LO Sync to set [On].

30. Press [SG1].

31. Press [Frequency] and set the frequency to 2110 MHz. The SG1 and SG2 frequencies become the same
value because the Local signal is synchronized.

32. Press [Level] and set the output level to —15 dBm.

33. Press [RF Output] = [Mod On/Off] and [On/Off] to set each to [On].

34. Press [SG2].

35. Press [Level] and set the output level to —15 dBm.

36. Press [2nd RF Output] = [Mod On/Off] and [On/Off] to set each to [On].

37. Press [SG1].

38. Press [Mode] = [—] = [F2] Start/Frame Trigger - [F3] Source-> [F2] Trigger Key.

39. Press Back - [F8] Trigger Key.

The above procedure outputs the Tx0 and Tx1 added signal from SG1 and the Tx2 and Tx3 added signal from SG2.

A1 MG3710A Vector Signal Generator =l Start/Frame Trieeer ‘%

2.110 000 000 00 @z  -15.00 &Bm

Frequency Amplitude Mod [[RF
®

2.110 000 000 00w.| —13.00 .

®

Source

Trigger Key

ARB Info {Combination}
FreqOfiset

i Package LTE_FDD Level
Pattern E-TM_.1-1_05MO =000 T3

LevelRatic 0.00 dB Event

= Package LTE_FDD Level No Retrigger
Pattern E-TM_1-1_05M 1 _18.01 dbim

Start Offset
1/2 4Ts
65 ns

Power Meter BER
A Off Stop 0.000E+000 0% .
B: Off 0 /0 Trigger Key

5/13/2013 074723
Fig. 5. Example of Four Antenna Signal Outputs (SG1 Setting Display)
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Measuring Timing Offset

The timing difference (offset) between the antenna signals is measured using the MS269xA Signal Analyzer.
Measurement is performed using the MX269020A LTE Downlink Measurement Software modulation analysis
function of the MS269xA Signal Analyzer measurement software.

Use the following MS269xA Signal Analyzer measurement procedure.

[Procedure]

1
2
3
4,
5.
6
7
8
9

Press [Application Switch] and select [3GLTE Downlink] ([LTE-TDD Downlink] for TDD).
Press [Frequency] and set the frequency to 2110 MHz.

Press [Amplitude] and set the level to —15 dBm.

Press [Measure] = [F2] MIMO Summary ([F3] MIMO Summary for TDD).

Press [F3] Channel Bandwidth - [F3] 5 MHz.

Press Back - [F7] Detail Settings.

Set [Number of Antenna Ports] to [4].

Press [Set] to display the Detail Settings log.

Press [Continuous] to start measurement and check the [RS Timing Offset] value.

The above procedure displays the timing offset for each antenna based on the TxO0 signal on the MS269xA Signal
Analyzer screen. The reference antenna is specified at the [Antenna Port] setting of [Detail Settings] in step 6.

AN MS26924
£ 3GLTE Downlink
: S R 2
Carrier Freq. 2110000000 Hz Input Level 15.00 dBm MIMO Summary

Modulation AUTO ATT 4 dB

Analysis

Channel Bandwidth 5MHz Reference Signal

Result WL

_ Tx0 I Rx Tx1 I Rx Tx2 [ Rx Tx3Rx
Reference

Chanel Bandwiddh
(RS Tmingofiset | 00ns | 326ns | 48ns | S0ns | e
(RSFreq | 000Hz | OAOWz | Omrz | 0zenz |

&

Detail Settings

Active Antenna L
Thresheld
-10.0dB

Ref.Int

Fig. 6. Example of Timing Offset Measurement between Four Antennas
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Measuring PDSCH EVM

The PDSCH EVM is measured using the timing offset measurement system. Measurement is performed using the
modulation analysis function of the MX269020A LTE Downlink Measurement Software for the MS269xA Signal
Analyzer. Additionally, each antenna signal is output from the MG3710A Vector Signal Generator.

The following measurement procedure follows on from the timing offset measurement using the MG3710A Vector
Signal Generator and MS269xA Signal Analyzer. After outputting the target measurement antenna signals from the
MG3710A Vector Signal Generator, measurement is performed by the signal analyzer.

Since the Synchronization Signal is embedded in the generated Tx1, Tx2, and Tx3 signals, the synchronization
mode is set to Reference Signal at measurement.

NOTE:
MX269020A LTE Downlink Measurement Software does NOT support to analyze pre-coded signal. Please turn off
the pre-coding when you measure signal from the base station.

Setting Signal Generator

[Procedure]

(1) Outputting TxO0

1. Press[SG1].

Press [Mode] = [—] = [F8] Sync Multi SG - [F1] Sync Type > [F1] Off.
Press [Mode] - [F3] ARB Setup - [F1] Output A to set [On].

Press [Mode] - [F3] ARB Setup - [F3] Output B to set [Off].

Set both of [RF Output] (SG1 side) [Mod On/Off] and [On/Off] to [On].

Set both of [2nd RF Output] (SG2 side) [Mod On/Off] and [On/Off] to [Off].
Use the signal analyzer to measure the PDSCH EVM of TxO0.

Nogakwn

(2) Outputting Tx1
8. Press [SG1].
9. Press [Mode] = [F3] ARB Setup - [F1] Output A to set [Off].
10. Press [Mode] = [F3] ARB Setup - [F3] Output B to set [On].
11. Use the signal analyzer to measure the PDSCH EVM of Tx1.

(3) Outputting Tx2

12. Press [SG2].

13. Press [Mode] - [F3] ARB Setup - [F1] Output A to set [On].

14. Press [Mode] = [F3] ARB Setup - [F3] Output B to set [Off].

15. Set both of [RF Output] (SG1 side) [Mod On/Off] and [On/Off] to [Off].

16. Set both of [2nd RF Output] (SG2 side) [Mod On/Off] and [On/Off] to [On].
17. Use the signal analyzer to measure the PDSCH EVM of Tx2.

(4) Outputting Tx3
18. Press [SG2].
19. [Press [Mode] = [F3] ARB Setup - [F1] Output A to set [Off].
20. Press [Mode] = [F3] ARB Setup - [F3] Output B to set [On].
21. Use the signal analyzer to measure the PDSCH EVM of Tx3.
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Fig. 7. Example of Tx0 Signal Output

Signal Analyzer Operation

[Procedure]

(1) Measuring Tx0

1. Press [Measure] - [F1] Modulation Analysis = [F7] Detail Settings.
2. Set [Synchronization Mode] to [Reference Signal].

3. Set[CellID]to 1.

4. Set [Number of Antenna Ports] to [4].

5. Set[Antenna Port] to [0].

6. Uncheck the [PDCCH] On/Off checkbox (set to [Off]).

7. Uncheck the [PHICH] On/Off checkbox (set to [Off]).

8. Press [Set] to close the [Detail Settings] dialog.

9. Press [Trace] -2 [F1] Trace Mode - [F6] Summary.

10. Press [Continuous] to start measurement and check the [PDSCH EVM (rms)] value.

(2) Measuring Tx1

11. Press [Measure] = [F1] Modulation Analysis = [F7] Detail Settings.

12. Set [Antenna Port] to [1].

13. Press [Set] to close the [Detail Settings] dialog.

14. Press [Continuous] to start measurement and check the [PDSCH EVM (rms)] value.

(3) Measuring Tx2

15. Press [Measure] - [F1] Modulation Analysis = [F7] Detail Settings.

16. Set [Antenna Port] to [2].

17. Press [Set] to close the [Detail Settings] dialog.

18. Press [Continuous] to start measurement and check the [PDSCH EVM (rms)] value.

(4) Measuring Tx3

19. Press [Measure] = F1] Modulation Analysis > [F7] Detail Settings.
20. Set [Antenna Port] to [3].

21. Press [Set] to close the [Detail Settings] dialog.
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22. Press [Continuous] to start measurement and check the [PDSCH EVM (rms)] value.
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Fig. 9. Tx0 PDSCH EVM Measurement Results
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Appendix

This demonstration uses the baseband addition function of a MG3710A Vector Signal Generator to output four
antenna signals from one MG3710A. However, it is also possible to use two MG3710A units without the baseband
addition function to allocate the four base station antenna signals in a 1:1 ratio to the four RF ports of the two vector
signal generators. Refer to the following Table 3 and Figure 10 for the differences when simulating signal output
from four antennas using the baseband signal addition function and one MG3710A, and when using two MG3710A
units without the baseband signal addition function.

Table 3. Examples of MG3710A Vector Signal Generator Configuration (with Four Tx Antennas).

Configuration 1
(Contents of this demonstration)

Configuration 2

No. of MG3710A Vector Signal 1 unit 2 units
Generators with 2ndRF option
No. of RF Ports 2 4
Requires Baseband Signal Yes No
Addition Option for Each RF Port
Extra Required Options - MG3710A-017 General /O
Extra Instruments - Frame Trigger Source (Function
Generator), Cables, etc., for
Synchronizing Trigger, Baseband
Clock, Local Signal, etc., between
Each Vector Signal Generator
Timing Adjustment Function Yes Yes
between Antennas
Phase Adjustment Function No Yes
between Antennas (Baseband Signal Addition
Function: No Phase Offset
Adjustment Between Memory A
and Memory B)
Fading Test Support for Each No Yes

Antenna Signal

This demonstration tested a multi-antenna transmitter but it cannot be used for a test of multi-antenna/MIMO
receivers with fading. The usual fading simulation calculates the MIMO matrix for the multiple antennas and outputs
these values at the independent RF ports. However, since these signals for each RF port are the signals at the
receiver antenna terminal, they contain a mixture of multiple channels. Consequently, attempting baseband signal
addition for these types of signals does not capture the actual test target signal.

Transmitter Test Measurement Point
(SG Output) - Configuration 1 or 2

X

Y
Y
Y

Y

TTT

Receiver Test Measurement Point
(SG/Fading Simulator Output) - Configuration 2

RX

Fig. 10. Measurement points for multi-antenna testing

Refer to the application note MG3710A-J-F-3 MIMO Phase Coherence using Vector Signal Generator for the
method for synchronizing between each RF port (Phase Coherence) using two MG3710A Vector Signal Generator
units, and the method for minimizing the timing and phase offsets between each RF port.
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